
  2-1 

 

 

 

Chapter 2  
Parametric Modeling Fundamentals 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Create Simple Extruded Solid Models 
 Understand the Basic Parametric 

Modeling Procedure 
 Create 2-D Sketches 
 Understand the "Shape before Size" 

Approach 
 Use the Dynamic Viewing Commands 
 Create and Edit Parametric Dimensions 
 



2-2         Parametric Modeling with NX   

 

Introduction 
 
The feature-based parametric modeling technique enables the designer to incorporate 
the original design intent into the construction of the model. The word parametric means 
the geometric definitions of the design, such as dimensions, can be varied at any time in 
the design process. Parametric modeling is accomplished by identifying and creating the 
key features of the design with the aid of computer software. The design variables, 
described in the sketches and described as parametric relations, can then be used to 
quickly modify/update the design. 
 
In NX, the parametric part modeling process involves the following steps: 

 
1. Set up Units and Part name. 
 
2. Determine the type of the base feature, the first solid feature, of the 

design. Note that Extrude, Revolve, or Sweep operations are the most 
common types of base features. 

 
3. Create a rough two-dimensional sketch of the basic shape of the base 

feature of the design. 
 

4. Apply/modify constraints and dimensions to the two-dimensional sketch. 
 

5. Transform the parametric two-dimensional sketch into a 3D solid. 
 

6. Add additional parametric features by identifying feature relations and 
complete the design. 

 
7. Perform analyses/simulations, such as finite element analysis (FEA) or 

cutter path generation (CNC), on the computer model and refine the 
design as needed. 

 
8. Document the design by creating the desired 2D/3D drawings. 

 
The approach of creating two-dimensional sketches of the three-dimensional features is 
an effective way to construct solid models. Many designs are in fact the same shape in 
one direction. Computer input and output devices we use today are largely two-
dimensional in nature, which makes this modeling technique quite practical. This method 
also conforms to the design process that helps the designer with conceptual design along 
with the capability to capture the design intent. Most engineers and designers can relate 
to the experience of making rough sketches on restaurant napkins to convey conceptual 
design ideas. NX provides many powerful modeling and design-tools, and there are many 
different approaches to accomplishing modeling tasks. The basic principle of feature-
based modeling is to build models by adding simple features one at a time. In this 
chapter, the general parametric part modeling procedure is illustrated; a very simple solid 
model with extruded features is used to introduce the NX user interface.  
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The Adjuster design 

 
Step 1: Starting NX and Units setup 
 

1. Select the NX option on the Start menu or select the NX icon on the desktop 
to start NX. The NX main window will appear on the screen. 

 
2. Select the New icon with a single click of the left-

mouse-button (MB1) in the Standard toolbar area.  
 
 The File New dialog box will appear on the screen 

with three option tabs: Model, Drawing and 
Simulation. Note that the default is set to Model and 
we can create a new model using any of the pre-
defined templates. 
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3. Select the Inches units as shown in the window. 

When starting a new CAD file, the first thing we 
should do is to choose the units we would like to 
use.  

 
4. Select Blank in the Template list. Note that the Blank template contains no 

pre-defined settings. 

 
 

5. In the New File Name section, enter Adjuster.prt as 
the File Name. 

 
 

6. Click OK to accept the settings and proceed with the new file command. 
 
7. Select the File tab with a 

single click of the left-mouse-
button (MB1) in the Ribbon 
bar area.  

 
8. Pick Modeling in the 

Applications list as shown in 
the figure. 

 
 
 
 
 

 
 The above procedure shows the switching of the three NX work areas, we have gone 

from the "Gateway" state to the “Applications”, and ”Task environments” state. 
In the later chapters, the procedure to use the pre-defined template is also illustrated. 

 
 Note that the NX Modeling application allows us to perform both the tasks of 

parametric modeling and Free-form Synchronous modeling. 
 
 Free-Form Synchronous Modeling  

We can also perform more complex-shape modeling tasks, such as the creation of 
complex surfaces and solid models. For example, creating swept features along 3D 
curves; lofted features using conic methods; and meshes of points and curves.  
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NX Application Screen Layout 
 

 The NX modeling screen layout is quite similar to the NX Gateway Application 
screen layout (refer to the figure in page 1-12). The new items on the screen include 
the Sketch toolbar, Form Feature toolbar, the Feature Operation toolbar, and the 
Curve toolbar.  

 
Sketch Toolbar  

 
This toolbar contains tools that allow us to 
quickly access 2D curve options.  
 
 
 
 
 
 
 

Form Feature Toolbar 
 
This toolbar contains tools that allow us to quickly create 2D 
sketches and form 3D features. 
 
 
 
 

Surface Toolbar Feature Operation 

Resource Bar 

Graphics 
Area 

Sketch Toolbar 
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Feature Operation Toolbar 
 

This toolbar contains tools that allow us to 
quickly create combined features and 
placed-features. 

 
 
 
 
 
 
 

 

Step 2: Define/Set Up the First Solid Feature 
 

 For the Adjuster design, we will create an extruded solid as the first feature. 
 
 
1. In the Feature Toolbar (toolbar next to the Sketch 

toolbar in the Ribbon Bar), select the Extrude 
icon as shown. 

 
 
 
 

 The Extrude Feature Options Dialogue box, which contains applicable construction 
options, is displayed as shown in the below figure. 

 
2. On your own, move the cursor over 

the icons and read the brief 
descriptions of the different options 
available. Note that the default 
extrude option is set to Select 
Curve. 

 
3. Click the Sketch Section button 

to begin creating a new 2D sketch. 
 

 
 
 Note the default sketch plane is aligned to the XC-YC plane 

of the displayed Work Coordinate System. 
 
 
 

 
4. Click OK to accept the default setting of the Sketch 

Plane. 
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Work Plane – It is an XY CRT, but an XYZ World 
 

 
Design modeling software is becoming more powerful and user friendly, yet the system 
still does only what the user tells it to do. When using a geometric modeler, we therefore 
need to have a good understanding of what its inherent limitations are. We should also 
have a good understanding of what we want to do and what to expect, as the results are 
based on what is available.  
 
In most 3D geometric modelers, 3D objects are located and defined in what is usually 
called the absolute space or global space. Although a number of different coordinate 
systems can be used to create and manipulate objects in a 3D modeling system, the 
objects are typically defined and stored using the absolute space. The absolute space is 
usually a 3D Cartesian coordinate system that the user cannot change or manipulate.  
 
In most engineering designs, models can be very complex, and it would be tedious and 
confusing if only one coordinate system, the absolute coordinate system, was available. 
Practical 3D modeling systems allow the user to define Work Coordinate Systems 
(WCS), also known as Local Coordinate Systems (LCS) or User Coordinate Systems 
(UCS) relative to the absolute coordinate system.  Once a local coordinate system is 
defined, we can then create geometry in terms of this more convenient system. 
 
The basic concepts of coordinate systems remain the same for most CAD systems, but 
the actual usage of a particular type of coordinate system may vary greatly from one 
CAD system to another. NX has two primary coordinate systems: the Absolute 
Coordinate System (ACS) and the Work Coordinate System (WCS). The ACS is 
fixed in space, where the WCS is a mobile system to facilitate geometry construction in 
different orientations. The WCS can be located and oriented anywhere in model space. 
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Although 3D objects are generally created and stored in 3D space coordinates, most of 
the 3D geometry entities can be referenced using 2D Cartesian coordinate systems. 
Typical input devices such as a mouse or digitizers are two-dimensional by nature; the 
movement of the input device is interpreted by the system in a planar sense. The same 
limitation is true of common output devices, such as CRT displays and plotters. The 
modeling software performs a series of three-dimensional to two-dimensional 
transformations to correctly project 3D objects onto a 2D picture plane.  
 
The NX sketch plane is a special construction tool that enables the planar nature of 2D 
input devices to be directly mapped into the 3D coordinate systems. The sketch plane is 
part of the NX work coordinate system that can be aligned to the absolute coordinate 
system, an existing face of a part, or a reference plane. By default, the sketch plane is 
aligned to the XY plane of the default WCS; note that the default WCS is aligned to the 
absolute coordinate system (ACS). 
 
Think of a sketch plane as the surface on which we can sketch the 2D sections of the 
parts. It is similar to a piece of paper, a white board, or a chalkboard that can be attached 
to any planar surface. The first profile we create is usually drawn on one of the work 
planes of the work coordinate system (WCS). Subsequent profiles can then be drawn on 
sketch planes that are defined on planar faces of a part, work planes aligned to part 
geometry, or work planes attached to a coordinate system (such as the XY, XZ, and 
YZ planes of WCS).   

 
 
 
 The default sketch plane is aligned to the XY plane of the 

Work Coordinate System. 
 
 
 
 
 
 The work coordinate system (WCS) is a mobile system to 

assists geometric constructions in different orientations. The 
WCS can be located and oriented anywhere in model space. 

 
 
 
 
 
 Note that most solid modeling operations do not require 

manipulation of the WCS. Features are generally added 
relative to existing geometry of the solid model. 
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Creating Rough Sketches  
 
Quite often during the early design stage, the shape of a design may not have any precise 
dimensions. Most conventional CAD systems require the user to input the precise lengths 
and locations of all geometric entities defining the design, which are not available during 
the early design stage. With parametric modeling, we can use the computer to elaborate 
and formulate the design idea further during the initial design stage. With NX, we can use 
the computer as an electronic sketchpad to help us concentrate on the formulation of 
forms and shapes for the design. This approach is the main advantage of parametric 
modeling over conventional solid-modeling techniques.  
 
As the name implies, a rough sketch is not precise at all. When sketching, we simply 
sketch the geometry so that it closely resembles the desired shape. Precise scale or 
lengths are not needed. NX provides us with many tools to assist us in finalizing sketches. 
For example, geometric entities such as horizontal and vertical lines are set automatically. 
However, if the rough sketches are poor, it will require much more work to generate the 
desired parametric sketches. Here are some general guidelines for creating sketches in 
NX: 
 
 Create a sketch that is proportional to the desired shape. Concentrate on the 

shapes and forms of the design. 
 
 Keep the sketches simple. Leave out small geometry features such as fillets, rounds 

and chamfers. They can easily be placed using the Fillet and Chamfer commands 
after the parametric sketches have been established.  

 
 Exaggerate the geometric features of the desired shape. For example, if the 

desired angle is 85 degrees, start by creating an angle that is 50 or 60 degrees (and 
make adjustment later). Otherwise, NX might assume the intended angle to be a 90-
degree angle. 

 
 Draw the geometry so that it does not overlap. To create a 3D features from a 2D 

sketch, the 2D geometry used should define a clear boundary. Self-intersecting 
geometry shapes are not allowed, as it cannot be converted into a solid feature. 

 
 The sketched geometric entities should form a closed region. To create a solid 

feature, such as an extruded solid, a closed region is required so that the extruded 
solid forms a 3D volume. 

 
 Note: The concepts and principles involved in parametric modeling are very 

different, and sometimes they are totally opposite, to those of conventional computer 
aided drafting. In order to understand and fully utilize NX’s functionality, it will be 
helpful to take a Zen approach to learning the topics presented in this text: 
Temporarily forget your knowledge and experiences of using conventional 
Computer Aided Drafting systems. 
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Sketch Settings  
 

 Prior to creating a 2D sketch, we will first examine the settings in the Sketch Settings 
command. The Sketch Settings command provides tools for controlling the behavior 
of sketching tools during the creation of 2D sketches. 

 
1. In the Task pull-down menu, aligned to the top of the main window, select 

the Sketch Settings command as shown.  

 
2. Turn off the Continuous Auto Dimensioning option by using the left-

mouse-button, MB1, as shown. 
 
 

 Note the different options under 
the Sketch Settings command are 
used during the creation of 2D 
sketches. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3. Click OK to accept the settings and exit the Sketch Style 

command. 
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 Step 3: Creating a Rough 2D Sketch  
 

 The Sketch Curve toolbar provides tools for creating and editing of the basic 2D 
geometry, construction tools such as lines, circles and editing tools such as trim, 
extend.  

 
1. Activate the Profile tool in the Sketch Curve toolbar as 

shown. 
 

 The Profile tool allows us to create lines and/or arcs 
that joined together.  

 
 
 
 Notice, by default, the Line option is activated. 

The line option allows us to create line segments 
that are joined together. 

 
 

 

2. As you move the cursor, you will see a digital readout next to the cursor. The 
readout gives you the cursor location relative to the Work Coordinate System. 
Pick a location that is toward the right side of the WCS as the first point of a line. 

 

3. Move the cursor around and you will notice the readout, next to the cursor, 
providing the length and angle of the line.  

 
4. Move the graphics cursor directly above the previous point and create a vertical 

line as shown below (Point 2). Notice the geometric constraint symbol displayed.  

Point 2  

Constraint 
Symbol

Length and 
Angle readout 

Point 1  
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Geometric Constraint Symbols 
 

NX displays different visual clues, or symbols, to show you alignments, 
perpendicularities, tangencies, etc. These constraints are used to capture the design intent 
by creating constraints where they are recognized. NX displays the governing geometric 
rules as models are built. To prevent constraints from forming, hold down the [Alt] key 
while creating an individual sketch curve. For example, while sketching line segments 
with the Line command, endpoints are joined with a coincident constraint, but when the 
[Alt] key is pressed and held, the inferred constraint will not be created. 
 
 
  Vertical   indicates a line is vertical 
 
   Horizontal  indicates a line is horizontal 
 
   Dashed line  indicates the alignment is to the center point or 
      endpoint of an entity 
 
   Parallel  indicates a line is parallel to other entities 
 
 
   Perpendicular   indicates a line is perpendicular to other entities 
 
 

Coincident         indicates the cursor is at the endpoint of an entity 
 
 
 
  Concentric   indicates the cursor is at the center of an entity 
 
 
  Tangent   indicates the cursor is at tangency points to curves 
 
 
  Midpoint   indicates the cursor is at the midpoint of an entity 
 
 
  Point on Curve  indicates the cursor is on curves 
 
 
  Equal Length  indicates the length of a line is equal to another line 
 
 
  Equal Radius  indicates the radius of an arc is equal to another arc 
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5. Complete the sketch as shown below, creating a closed region ending at the 

starting point (Point 1.) Do not be overly concerned with the actual size of the 
sketch. Note that all line segments are sketched horizontally or vertically.  

 
6. Inside the graphics window, click twice with the middle-mouse-button 

(MB2), or press the [Esc] key twice, to end the Sketch Line command.  
 

Step 4: Apply/Modify Constraints and Dimensions 
 

 As the sketch is made, NX automatically applies some of the geometric constraints 
(such as horizontal, parallel, and perpendicular) to the sketched geometry. We can 
continue to modify the geometry, apply additional constraints, and/or define the size 
of the existing geometry. In this example, we will illustrate adding dimensions to 
describe the sketched entities. 

 

1. Move the cursor to the Geometric Constraints toolbar area, which is located to 
the right of the Sketch Curve toolbar.  

 
2. Activate the Rapid Dimension 

command by left-click once on the 
icon as shown. The Rapid Dimension 
command allows us to quickly create 
and modify dimensions. 

Point 1 

Point 2 Point 3 

Point 5  

Point 6  

Point 4 
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3. The message “Select object to Dimension or select dimension to edit” is 
displayed in the Message area. Select the Top horizontal line by left-clicking 
once on the line.  

 
4. Move the graphics cursor above the selected line and left-click to place the 

dimension. (Note that the value displayed on your screen might be different 
than what is shown in the figure above.)  

 
 The Rapid Dimension command will create a length dimension if a single 

line is selected. The current length of the line is displayed, in the Edit box, 
next to the dimension as shown in the below figure. 

 
5. Enter 2.5 as the desired length of the line. (Press the Enter key once after you 

entered the new value.)  

 
 NX will now update the profile with the new dimension value. Note that in 

parametric modeling, dimensions are used as control variables.  
 
 

3. Pick the top horizontal 
line as the object to 
dimension. 

4. Pick a location above 
the line to place the 
dimension. 

4. Enter 2.5 to adjust the 
length of the line. 
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6. Click the Fit button, or use hotkey 

[Ctrl+F], to resize the display window. 
 
 
 
 

 

 Note that we are returned to the Rapid Dimension command, the Fit command is 
executed without interrupting the current active command. 

 

7. The message “Select object to Dimension or select dimension to edit” is 
displayed in the Message area. Select the top-horizontal line as shown below.  
 

8. Select the bottom-horizontal line as shown below. 

 
9. Pick a location to the left of the sketch to place the dimension. 

 

10. Enter 2.5 as the desired length of the line.  

 

 When two parallel lines are selected, the Rapid Dimension command will create a 
dimension measuring the distance between them. 

8. Pick the bottom line 
as the 2nd geometry to 
dimension. 

7. Pick the top line as the 
1st geometry to dimension. 

9. Place the dimension 
next to the sketch. 

10. Enter 2.5 to adjust 
the length of the line. 
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 Quick Zoom function by Turning the mouse wheel 
 

Turning the mouse wheel can adjust the scale of the 
display. Turning forward will reduce the scale of the 
display, using the cursor location as the center reference, 
making the entities display smaller on the screen. Turning 
backward will magnify the scale of the display. 

 
 

11. The message “Select object to Dimension or select dimension to edit” is 
displayed in the Message area. Select the bottom-horizontal line as shown 
below.  

 
 

12. Pick a location below the sketch to place the dimension. 
 

13. Enter 0.75 as the desired length of the line. 

 

  
 
14. Pick the vertical dimension and notice 

the Rapid Dimension command can 
also be used to adjust any existing 
dimensions. 

 
15. On your own, enter any number and 

observe the adjustment done by NX. 
 

11. Pick the bottom-
horizontal line as the 
geometry to dimension. 

12. Place the dimension 
below the sketch. 

13. Enter 0.75 to adjust 
the length of the line. 
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16. Inside the graphics window, click once with the middle-mouse-button 
(MB2), or hit the [Esc] key once, to end the Rapid Dimension command.  

 
 
 
17. To reposition any of the dimensions, simply 

press and drag with the left-mouse-button 
(MB1) on the dimension as shown in the 
figure. 

 
 
 
18. On you own, repeat the above steps, create and 

modify dimensions so that the sketch appears 
as shown in the below figure.  

 

 
 The Rapid Dimension command is also known as the Smart Dimension command; 

dimensions are created based on the selection of the types and orientations of objects. 
You might want to read through this section again and consider the powerful 
implication of this command. Also consider this question: How would you create an 
Angle dimension using the Rapid Dimension command? 
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Quick View Functions 
 
 NX provides a special user interface called Quick View Bar that enables convenient 

viewing of the entities in the graphics window.  
  

 
 
 
1. Click on the Pan icon, located in the Quick View Bar as 

shown. The icon is the picture of a hand. 
 
 

 

 The Pan command enables us to move the view to a different position. This function 
acts as if you are using a video camera. 

 
 
Dynamic Viewing Functions 
 

 NX also provides a special user interface called Dynamic Viewing through the use of 
the three mouse buttons. 
 
 
 
 

 
 
 
 

 
 

1. On your own, use the dynamic Zoom and Pan options by the mouse buttons 
to reposition the sketch near the center of the screen. 
 
 
 

Quick View Bar 
Zoom All (Fit)Zoom window

Rotate
Pan

(MB1+MB2) or 
[CTRL]+MB2 

(MB2+MB3) or 
[Shift]+MB2 

MB2 
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Step 5: Completing the Base Solid Feature 
 
Now that the 2D sketch is completed, we will proceed to the next step: create a 3D part 
from the 2D section. Extruding a 2D section is one of the common methods that can be 
used to create 3D parts. We can extrude planar faces along a path. We can also specify a 
height value and a tapered angle. In NX, each face has a positive side and a negative side, 
the current face we're working on is set as the default positive side. This positive side 
identifies the positive extrusion direction and it is referred to as the face's normal. 

 
 
1. Select Finish Sketch by clicking once with the left-

mouse-button (MB1) on the icon. 
 
 
 

 
 
2. In the Extrude popup 

window, enter 2.5 as the 
extrusion distance. Notice 
that the sketch region is 
automatically selected as the 
extrusion section. 

 
 
 
 
 
 

 
3. Click on the OK button to proceed with 

creating the 3D part. 
 

 
 

 Note that all dimensions 
disappeared from the screen. All 
parametric definitions are stored in 
the NX database and any of the 
parametric definitions can be 
displayed and edited at any time. 

 
 
 
 

2. Enter 2.5
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Display Orientations 
 
 NX provides many ways to display views of the three-dimensional design. Several 

options are available that allow us to quickly view the design to track the overall 
effect of any changes being made to the model. We will first orient the model to 
display in the Front view, by using the View Toolbar.  

 
1. Select Front View in the View tab to change the display to the front view.  (Note 

that [Ctrl+Alt+F] can also be used to activate this command.) 

 
 
2. Select Top View in the View toolbar to change 

the display to the top view.  (Note that the 
[Ctrl+Alt+T] key can also be used to activate 
this command.) 

 
 
 
 
 
3. Select Right View in the View toolbar to change 

the display to the right side view.  (Note that the 
[Ctrl+Alt+R] key can also be used to activate 
this command.) 

 
 
 
 
 
4. Select Isometric View in the View toolbar to 

change the display to the isometric view.  (Note 
that the [End] key can also be used to activate 
this command.) 

 
 Notice the other view-related commands that are 

available under the View toolbar.  
 



                                                                                       Parametric Modeling Fundamentals 2-21 

 

Dynamic Viewing – Icons, Mouse buttons and Quick keys 
 
 The 3D Rotate icon is the icon with two circular arrows in the View toolbar circular 

rim with four handles and a center mark. 3D Rotate enables us to manipulate the view 
of 3D objects by clicking and dragging with the left-mouse-button: 

 

 
1. Click on the Rotate icon in the View toolbar. 
 

2. Drag with the left-mouse-button (MB1) for free 
rotation of the 3D model. 

 
3. Press the [F7] key (toggle switch) once to exit the 3D rotate command. 

 

 We can also use the mouse buttons to access the Dynamic Viewing functions. 
 
 

 3D Dynamic Rotation – The Middle-Mouse-Button (MB2) 
 

Hold and drag with the middle-mouse-button to rotate the display interactively.  
 
 

          
 
Dynamic Rotation               MOUSE 
 
 
 
 
 
 

 Panning –  (1) The Middle and Right Mouse Buttons 
 

Hold and drag with the middle and right mouse buttons (MB2+MB3) to pan the 
display. This allows you to reposition the display while maintaining the same 
scale factor of the display.  
 

 
 
 
 Pan                    MOUSE 
 
 
 
 
 

(2) [Shift] + [Middle-mouse-button (MB2)] 
 

Hold the [Shift] key and the [middle-mouse-button(MB2)] to pan the display.  

Hold and drag (MB2)

(MB2+MB3)
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 Zooming – The Left and Middle Mouse Buttons 
 

Hold and drag with the left and middle mouse buttons (MB1+MB2) vertically on 
the screen to adjust the scale of the display. Moving upward will magnify the 
scale of the display, making the entities display larger on the screen. Moving 
downward will reduce the scale of the display. 
 

 
 
 
 Zoom                    MB1+MB2 
 
 
 
 
 
 
(2) [Shift] + [Middle mouse button (MB2)] 
 

Hold the [Shift] key and the [middle-mouse-button(MB2)] to pan the display.  
 
 
 
 Zoom            Shift     +          MB2 
 
 
 
 

 
(3) Turning the mouse wheel 
 

Turning the mouse wheel can also adjust the scale of the 
display. Turning forward will reduce the scale of the 
display, making the entities display smaller on the screen. 
Turning backward will magnify the scale of the display. 

 
 

 Note that the dynamic viewing functions are also available through the Quick View 
Toolbar.  

 
 

(MB1+MB2)
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Display Modes 
 
 The display in the graphics window has two basic display-modes: wireframe and 

shaded display. To change the display mode in the active window, click on the 
triangle icon next to the display mode button on the View toolbar, as shown in the 
figure. 

 
1. Pick the Wireframe with Dim Edges option as 

shown in the figure. 
 
 
 
 

 
 
 

 Wireframe with Dim Edges  
 
This display mode generates an image of the 
3D object with all the back lines shown as 
lighter edges. 

 
 
 
 
 

 
 
 
 
2. Pick the Shaded with Edges option as 

shown. 
 
 

 
 
 Shaded with Edges Image  

 

This display mode option generates a shaded 
image of the 3D object with the edges 
highlighted. 

 
 On your own, use the different options to 

familiarize yourself with the 3D 
viewing/display commands.  
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Step 6-1: Adding an Extruded Feature 

1. In the Feature Toolbar (toolbar next to the
Sketch toolbar in the Ribbon Bar), select the
Extrude icon as shown.

2. In the Message area, the message: “Select planar face to sketch or select
section geometry” is displayed. NX expects us to identify a planar surface
where the 2D sketch of the next feature is to be created. Move the graphics
cursor on the 3D part and notice that NX will automatically highlight feasible
planes and surfaces as the cursor is on top of the different surfaces. Pick the
back vertical face of the 3D solid object, with the new work coordinate
aligned to the upper left corner, as shown.

 Note that the sketch plane is aligned to the
selected face. NX automatically establishes a
Work-Coordinate-System (WCS), and
records its location with respect to the part on
which it was created.

2. Pick the back face
of the solid model. 
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 Next, we will create another 2D sketch, which will be used to create another
extrusion feature that will be added to the existing solid object.

3. On your own, create a 2D sketch consists of horizontal/vertical lines as shown
in the below figure. Note that we intentionally do not want to align the new
sketch to any of the corners of the 3D model.

 Note that since we did not modify the Sketch Settings, both the
Constraints and dimensions are automatically applied to the sketch.

4. Activate the Rapid Dimension
command by left-click once on the
icon as shown.

5. Create and modify the four size dimensions to describe the size of the sketch
as shown. (Note that NX will maintain the right amount of dimensions to the
sketch without over-constraining the sketch.)
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6. Modify the two location dimensions to 0.0, this will align the position of the
sketch relative to the top corner of the solid model as shown.

7. Select Finish Sketch by clicking once with the
left-mouse-button (MB1) on the icon.

8. In the Extrude popup window,
select Unite as the Extrude
Boolean option.

 The Unite option will ADD the new feature to the existing solid. Note that the default
option was set to Inferred, which means NX will determine the option based on the
type of sketches created.
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9. In the Extrude popup window, enter 

2.5 as the extrusion distance.  
 
 
 
 
 
 
 
 
 

10. Use the Reverse Direction icon to toggle the extrusion direction so that the 
extrusion appears as shown in the above figure. 

 
 

 

11. Click on the OK button to 
proceed with creating the 
3D feature. 

 

 
 
 
 
 
 
 
 
 
 
 

 

12. Enter 2.5
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Step 6-2: Adding a Cut Feature 

 Next, we will create and profile a circle, which will be used to create a cut feature
that will be added to the existing solid object.

1. In the Feature Toolbar (toolbar next to the
Sketch toolbar in the Ribbon Bar), select the
Extrude icon as shown.

2. In the Message area, the message: “Select planar face to sketch or select
section geometry” is displayed. NX expects us to identify a planar surface
where the 2D sketch of the next feature is to be created. Move the graphics
cursor on the 3D part and notice that NX will automatically highlight feasible
planes and surfaces as the cursor is on top of the different surfaces. Pick the
horizontal face of the 3D solid object, with the Work Coordinate system
aligned to the left corner as shown.

 Note that the sketch plane is aligned to the selected
face. NX automatically establishes a Work-
Coordinate-System (WCS), and records its location
with respect to the part on which it was created.

2. Pick the horizontal
face of the solid model. 
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3. Select the Circle command by clicking once with the left-mouse-button (MB1) 
on the icon in the Sketch Curve toolbar. 

 
 
4. Reset the display to the Isometric view display as 

shown. 
 

 
 

 
 

5. Create a circle of arbitrary size 
on the horizontal face of the 
solid model as shown. 

 
 
 
 

6. On your own, modify the dimensions of the sketch as shown in the figure. 
(Hint: there are two locational dimensions and one size dimension.)  
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7. Select Finish Sketch by clicking once with the left-

mouse-button (MB1) on the icon. 
 
 
 
 

 
8. In the Extrude popup window, 

select Subtract as the Extrude 
Boolean option.  

 
 The Subtract option will Remove 

the volume of the new feature to 
the existing solid. Note that the 
default option was set to Create, 
which will create a new solid 
model. 

 
 
 
9. In the Direction option box, use the 

Reverse Direction icon to toggle 
the extrusion direction so that the 
extrusion cut through the bottom 
section of the model. 

 
 
 
10. In the Limits option box, choose the 

Through All option to set the End 
extrusion limit.  

 
 
11. Click on the OK button to proceed 

with creating the 3D feature. 
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Step 6-3: Adding another Cut Feature 

 Next, we will create and profile a triangle, which will be used to create a cut
feature that will be added to the existing solid object.

1. In the Feature Toolbar (toolbar next to the
Sketch toolbar in the Ribbon Bar), select the
Extrude icon as shown.

2. In the Message area, the message: “Select planar face to sketch or select
section geometry” is displayed. NX expects us to identify a planar surface
where the 2D sketch of the next feature is to be created. Move the graphics
cursor on the 3D part and notice that NX will automatically highlight feasible
planes and surfaces as the cursor is on top of the different surfaces. Pick the
horizontal face of the 3D solid object, with the Work Coordinate system
aligned to the left corner as shown.

 Note that the sketch plane is aligned to the selected
face. NX automatically establishes a Work-
Coordinate-System (WCS), and records its location
with respect to the part on which it was created.

2. Pick this vertical
face of the solid model. 
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3. Use the Profile command and start 

the first line segment at the top left 
corner as shown. 
 

 
 
 
 
 
 
 

 
 
 

4. Place the second point aligned to 
and below the mid-point of the left 
edge as shown. 

 
 
 
 
 

 
 
 
 

5. Place the second point aligned to and 
below the mid-point of the left edge 
as shown. 
 
 
 
 
 

 
 
 

6. Complete the profile by connecting to 
the first point as shown. 
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7. Activate the Rapid Dimension command by clicking 

on the icon as shown. 
 
 

 
8. Create and modify the linear dimension on top as shown. 

 
9. Select the two line segments and place the angular dimension inside the 

triangle to create the associated angle dimension.  

 
 
10. On your own, modify 

the two dimensions as 
shown. 
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11. Select Finish Sketch by clicking once with the left-

mouse-button (MB1) on the icon. 
 
 
 

 
12. In the Extrude popup window, 

select Subtract as the Extrude 
Boolean option.  

 
 The Subtract option will Remove 

the volume of the new feature to 
the existing solid. Note that the 
default option was set to Create, 
which will create a new solid 
model. 

 
 
 
13. In the Direction option box, use the 

Reverse Direction icon to toggle 
the extrusion direction so that the 
extrusion cut through the bottom 
section of the model. 

 
 
 
14. In the Limits option box, choose 

the Until Next option to set the 
End extrusion limit.  

 
 
15. Click on the OK button to proceed 

with creating the 3D feature. 
 

 
 
 
 
 
 
 
 
 
 



                                                                                       Parametric Modeling Fundamentals 2-35 

 

 On your own, use the dynamic viewing functions and examine the completed 
solid model.  

 
Save the Model and Exit NX 

 
 
1. Select Save in the File pull-down menu, or you can also 

use the “Ctrl-S” combination (hold down the “Ctrl” key 
and hit the “S” key once) to save the part.  

 
 
 

 You should form a habit of saving your work periodically, just in case something 
might go wrong while you are working on it. In general, one should save one’s work 
at an interval of every 15 to 20 minutes. One should also save before making any 
major modifications to the model. 

 
 
2. Select Exit in the File pull-down 

menu to exit NX.  
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Review Questions: 
 
1. What is the first thing we should set up in NX when creating a new model? 
 
2. Describe the general parametric modeling procedure. 
 
3. List two of the geometric constraint symbols used by NX. 
 
4. What was the first feature we created in this lesson? 
 
5. Describe the steps required to define the orientation of the sketching plane? 
 
6. How do we change the size of 2D geometry in the 2D sketcher mode? 
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Exercises: (All dimensions are in inches.) 
 
1.  Plate Thickness: .25 

 
 
2. Plate Thickness: .5 
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3.     

 
4. 

 
 




